
Škoda Kamiq
CenCenník (platnník (platný od 01.01.2025 s DPH 23%)ý od 01.01.2025 s DPH 23%)

* Dostupné už len skladové zásoby

Zistite viac

Motor PalivPalivoo PrPreevvodoodovkavka PohonPohon Essence Selection Top Selection* Monte Carlo

1.0 TSI 70kW (95k) Benzín 5° MP predný 20 390 22 030 24 490 25 750
1.0 TSI 85kW (116k) Benzín 6° MP predný 21 840 23 460 25 920 27 170
1.0 TSI 85kW (116k) Benzín 7° AP DSG predný 23 890 25 560 28 020 29 280
1.5 TSI 110kW (150k) Benzín 6° MP predný - 24 990 27 450 28 700
1.5 TSI 110kW (150k) Benzín 7° AP DSG predný - 27 090 29 550 30 810
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Prečo práve Kamiq?

SUV do mesta

Kompaktné rozmery vozidla sa hodia pri parkovaní v preplnených
uliciach a vyššia svetlá výška príde vhod nielen mimo spevnenej
komunikácie, ale aj pri parkovaní pri chodníkoch. S parkovaním môžu
ďalej pomôcť predné aj zadné parkovacie senzory alebo zadná
parkovacia kamera.

Špičková výbava

Full LED Matrix predné svetlomety, elektricky odistiteľné a sklopné
ťažné zariadenie alebo vyhrievané čelné sklo sú len výberom zo
špičkových prvkov výbavy, ktoré si môžete vo svojom Kamiqu
dopriať.

S prehľadom

Vyššia stavba modelu Kamiq prenáša svoje pozitíva aj do interiéru,
kde cestujúci sedí vyššie ako v bežnom vozidle, a vodič tak má lepší
prehľad o okolitom dianí. Priestranný interiér vyhovie nárokom rodiny
s batožinovým priestorom s objemom 400 litrov. Detaily v podobe
háčikov na tašky a sieťového programu si nebudete môcť
vynachváliť.

Monte Carlo

Priaznivcom športového dizajnu sme pripravili exkluzívnu verziu
Monte Carlo. Dizajnové detaily v lesklej čiernej farbe, čierna
panoramatická strecha a špecifické kolesá spestrujú vonkajší dizajn
vozidla, zatiaľ čo vnútri sa budete cítiť ako v športovom vozidle vďaka
predným sedadlám, trojramennému volantu, krytom pedálov z
ušľachtilej ocele a čiernemu stropu.

Vyberte si svoj interiér

Loft Lodge

Suite Dynamic
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Základná výbava

Interiér Studio

Airbag vodiča a spolujazdca, airbag spolujazdca s deaktiváciou

Hlavové airbagy a bočné airbagy vpredu

ESC vrátane ABS, EBV, MSR, ASR, EDS, HBA, DSR, ESBS, XDS+,
TPM, multikolíznej brzdy (MKB) a funkcie Prefill

Front Assist - výstraha pred kolíziou a podpora núdzového brzdenia
a Pederstrian Monitor (ochrana chodcov)

Easy Light Assist – svetelný senzor

Lane Assist – asistent udržiavania v jazdnom pruhu

ISOFIX na sedadle spolujazdca

3. hlavová opierka vzadu

Centrálne zamykanie s diaľkovým ovládaním, 2 sklopné kľúče

Full LED predné svetlomety

Oceľové disky kolies 6J × 16" s krytmi Tecton

Brzdy kotúčové (predné aj zadné)

Virtuálny kokpit 8"

Čítanie dopravných značiek

2-ramenný PUR volant

Obmedzovač rýchlosti

Infotainment Škoda s 8" displejom, 2x USB-C vpredu

eCall, CareConnect na 3 roky

Bluetooth

Manuálna klimatizácia s peľovým filtrom

Výškovo nastaviteľné sedadlo vodiča

Zadné parkovacie senzory

Driver Alert - asistent rozpoznania únavy

Elektricky ovládané a vyhrievané vonkajšie spätné zrkadlá

Vonkajšie spätné zrkadlá a kľučky dverí lakované vo farbe karosérie

Strešný nosič - čierny

Elektrické ovládanie okien vpredu

Asistent rozjazdu do kopca (iba pre AP)

Paket Simply Clever: háčiky na tašky – pevné, nesklopné, odkladacia
schránka – na strane za podbehom, uchytávacie klipy pre sieťový
program, sieťový program, 12V zásuvka v batožinovom priestore

Rezerva na oceľovom disku (neplnohodnotná), zdvihák, kľúč
na kolesá

Predĺžená záruka na 5 rokov/100 000 km
(Platí tá z podmienok, ktorá nastane skôr, prvé 2 roky bez
obmedzenia počtu kilometrov)

Premenlivý servisný interval s výmenou oleja až 30 000 km alebo
každé 2 roky

Škoda – Doživotná Garancia Mobility Premium
Poskytuje pomoc servisným vozidlom na mieste poruchy (porucha
na vozidle, chýbajúce PHM, defekt pneumatiky, zabuchnuté/stratené
kľúče, vybitá batéria, zámena paliva), odtiahnutie vozidla, prípadne
služby – náhradnú dopravu, požičanie náhradného vozidla,
ubytovanie pre posádku a i.

Interiér Loft

Asistent rozjazdu do kopca

Disky Nyota z ľahkej zliatiny 6J × 16" – strieborné

Predné hmlové svetlá

Vnútorné spätné zrkadlo s automatickým stmavovaním

2-ramenný multifunkčný kožený volant (pre AP s podvolantovým
ovládaním DSG)

Easy Start – bezkľúčové štartovanie

Tempomat

Lakťová opierka s JumboBox

2× USB vzadu (typ C len na nabíjanie)

Bezdrôtový Smartlink

Ďalšie 4 reproduktory vzadu

Elektrické ovládanie okien vzadu

Climatronic – dvojzónová automatická klimatizácia so senzorom
vlhkosti a kombi filtrom

Vyhrievanie predných sedadiel

Výškovo nastaviteľné sedadlo vodiča a spolujazdca

Ukazovateľ stavu kvapaliny v ostrekovači

Dáždnik

Interiér Lodge

Dažďový senzor

KESSY - bezkľúčové odomykanie, zamykanie a štartovanie

Alarm

Full LED Matrix predné sveltomety

Predné hmlové svetlá s corner funkciou

Full LED zadné svetlá s dynamickým ukazovateľom smeru

Disky z ľahkej zliatiny Stratos 6,5J x 17"

2-ramenný vyhrievaný multifunkčný kožený volant (pre AP
s podvolantovým ovládaním DSG)

Ambientné osvetlenie prepínateľné biela/červená

Zadná lakťová opierka

Predné a zadné parkovacie senzory

Driving Mode Select

Zadná parkovacia kamera

Sunset

Podokenná chrómová lišta

Elektricky sklopné, ovládané a vyhrievané vonkajšie spätné zrkadlá
s automatickým stmievaním na strane vodiča

Strieborný strešný nosič

Essence

Selection (navyše oproti Essence)

Top Selection (navyše oproti Selection)
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Základná výbava

Interiér Monte Carlo

Dažďový senzor

KESSY - bezkľúčové odomykanie, zamykanie a štartovanie

Full LED Matrix predné sveltomety

Predné hmlové svetlá s corner funkciou

Full LED zadné svetlá s dynamickým ukazovateľom smeru

Panoramatická strecha

Čierny strop

Disky Kajam Aero z ľahkej zliatiny 6,5J × 17" – čierne

Kryty pedálov z ušľachtilej ocele

Ambietné osvetlenie prepínateľné biela/červená

3-ramenný vyhrievaný multifunkčný kožený volant (pre AP
s podvolantovým ovládaním DSG)

Zadná lakťová opierka

Predné a zadné parkovacie senzory

Driving Mode Select

Zadná parkovacia kamera

Sunset

Elektricky sklopné, ovládané a vyhrievané vonkajšie spätné zrkadlá
s automatickým stmievaním na strane vodiča

Strešný nosič - čierny lesklý

Vkladané tkané koberce vpredu a vzadu

Doplnková výbava

Essence Plus › Elektricky ovládané zadné okná
› Výškovo nastaviteľné sedadlo spolujazdca
› Predné hmlové svetlá
› Tempomat
› Vkladané tkané koberce vpredu a vzadu

WIL 544

Light & View › Dažďový senzor
› Full LED zadné svetlá s dynamickým

ukazovateľom smeru
› Predné hmlové svetlá s corner funkciou
› Elektricky sklopné vonkajšie spätné zrkadlá
› Elektrické ovládanie okien vzadu (iba

pre Essence)
(WYH platí len pre Selection iba v kombinácii
s WIS/WI2/PMA)
(WYH nie je možné s PYB)

WIH/WYH 852 475 • •

Light & View Plus › Naviac oproti Light & View:
› Full LED Matrix predné svetlomety

(WYI platí iba v kombinácii s WIS/WI2/PMA)

WII/WYI − 1304 • •

Monte Carlo (navyše oproti Selection)

Essence Selection Top Selection Monte CarloAkčné pakety

Essence Selection Top Selection Monte CarloBezpečnosť
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Adaptive Cruise Control - adaptívny tempomat do 210km/h PC5 − 485 485 485

Assisted Drive › Adaptive Cruise Control - adaptívny
tempomat do 210km/h

› Adaptive Lane Assist

PIA − 662 662 662

Assisted Drive Plus › Naviac oproti Assisted Drive
› Side Assist
› Dažďový senzor
› Full LED zadné svetlá s dynamickým

ukazovateľom smeru
› Predné hmlové svetlá s corner funkciou
› Elektricky sklopné vonkajšie spätné zrkadlá

(PYB platí iba v kombinácii s WIS/WI2/PMA)

PIB/PYB − 1330 855 855

Safety › Crew Protect Assist – proaktívna ochrana
cestujúcich

› Kolenný airbag vodiča
› Bočné airbagy vzadu

WIX − 539 539 539

Deliaca sieťová stena 3CX 125 125 125 125

Medzipodlaha batožinového priestoru 3GD 179 179 179 179

Simply Clever Plus › Sieťový program
› Odkladací priestor pod prednými sedadlami
› Ochrana hrán bočných dverí
› Obojstranný koberec v batožinovom priestore
› Odpadkový kôš
› Odkladací priestor s flexibilným držiakom

na zadnom tuneli
› Držiak na tablet a telefón

(nie je možné s PWA/WQ7)

PIK 277 277 277 277

Simply Clever Plus
(pre elektricky
nastaviteľné sedadlo
vodiča)

› Sieťový program
› Ochrana hrán bočných dverí
› Obojstranný koberec v batožinovom priestore
› Odpadkový kôš
› Odkladací priestor s flexibilným držiakom

na zadnom tuneli
› Držiak na tablet a telefón

(možné len s PWA/WQ7)

PI2 − 240 240 240

Príprava na ťažné zariadenie 1D7 214 214 214 214

Ťažné zariadenie – sklopné 1M6 1128 1128 1128 1128

Adaptér pre ťažné zariadenie ND1 40 40 40 40

Ostrekovače svetlometov 8X1 155 155 155 155

Interiér Lodge › Láťkové sedadlá Lodge
› Ambientné osvetlenie červené /biele
› Sivý poťah prístrojovej dosky
› Medené orámovanie výduchov ventilácie
› Zadná ľakťová opierka
› Vkladané tkané koberce vpredu a vzadu

(iba s interiérom HP/HQ)

WQ3 − 498 • −

Interiér Dynamic › Športové sedadlá
› Čierny strop
› 3-ramenný kožený športový multifunkčný

volant (pre AP s podovlantovým ovládaním
DSG)

› Ambientné osvetlenie červené /biele
› Čierny poťah prístrojovej dosky
› Červené orámovanie výduchov ventilácie
› Kryty pedálov z ušľachtilej ocele
› Zadná ľakťová opierka
› Vkladané tkané koberce vpredu a vzadu
› Prahové lišty s názvom Kamiq

(iba s interiérom AH)

WQ4 − 989 − −

Essence Selection Top Selection Monte CarloBezpečnosť

Essence Selection Top Selection Monte CarloFunkčnosť

Essence Selection Top Selection Monte CarloVolanty / interiéry / sedadlá
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Interiér Suite › Poťah sedadiel Suedia /koža /umelá koža
› Čierny poťah prístrojovej dosky
› Chrómové orámovanie výduchov ventilácie
› Zadná ľakťová opierka
› Elektricky nastaviteľné sedadlo vodiča
› Ambientné osvetlenie červené /biele
› Vkladané tkané koberce vpredu a vzadu
› Prahové lišty s názvom Kamiq

(iba s interiérom JG/JI)

WQ7 − 1673 − −

Elektricky nastaviteľné sedadlo vodiča (možné len s WQ3/WQ4, nie je
možné s PIK)

PWA − 495 495 495

2-ramenný kožený multifunkčný volant (možné len s WIL) PLC 372 • − −

2-ramenný kožený vyhrievaný multifunkčný volant PLE − 107 • −

3-ramenný kožený vyhrievaný športový multifunkčný volant PLM − 244 244 −

2-ramenný kožený vyhrievaný multifunkčný volant pre DSG PLG − 107 • −

3-ramenný kožený vyhrievaný športový multifunkčný volant pre DSG PLP − 244 244 −

3-ramenný kožený športový multifunkčný volant PLK − 137 − −

3-ramenný kožený športový multifunkčný volant pre DSG PLN − 137 − −

Disky z ľahkej zliatiny Cortadero Aero 6J x 16" (205/60) P02 632 0 − −

Disky z ľahkej zliatiny Nyota 6J x 16" (205/60) P06 713 • − −

Disky z ľahkej zliatiny Montado Aero 6J x 16" – čierne (205/60) P08 856 142 − −

Disky z ľahkej zliatiny Kajam 6,5J x 17" (205/55) PJG − 599 39 −

Disky z ľahkej zliatiny Stratos 6,5J x 17" (205/55) PJP − 559 • −

Disky z ľahkej zliatiny Propus Aero 6,5J x 17" – čierne (205/55) PJR − 701 142 −

Disky z ľahkej zliatiny Ursa Aero 7J x 18" – čierne (215/45) P20 − 1219 659 −

Disky z ľahkej zliatiny Fornax 7J x 18" – strieborné (215/45) PJN − 1177 618 −

Disky z ľahkej zliatiny Vega Aero 7J x 18" – čierne (215/45) PJV − 1321 762 −

Disky z ľahkej zliatiny Ursa 7J x 18" – čierne (215/45) PJI − − − 578

Winter › Vyhrievané predné sedadlá
› Ukazovateľ stavu kvapaliny v ostrekovači

WIC 238 • • •

Winter Premium › Vyhrievané čelné sklo
(možné len s PLG/PLP/PLE/PLM)
(nie je možné s 4A4)

WIE − 166 166 166

Winter Premium &
Technology Plus

› Vyhrievané čelné sklo
› Phonebox bez LTE
› USB-C vo vnútornom spätnom zrkadle

(možné len s PLG/PLP/PLE/PLM)
(nie je možné s 4A4)
(WI3 platí pre Monte Carlo)

PMA/WI3 − 351 351 351

Paket pre zlé cesty (dodatočná ochrana podvozka)
(nie je možné s 18" diskami)

1SK 72 72 72 −

Vyhrievané zadné sedadlá (nie je možné s WIE/PMA/WI3) 4A4 − 191 191 191

Drive › Zadná parkovacia kamera
› Kessy - bezkľúčové odomykanie, zamykanie

a štartovanie
› Čierne lakované spätné zrkadlá a predná

maska
› 10" Virtuálny kokpit
› Sunset
› Sport Chassis Control–podvozok

s nastaviteľnou tuhosťou tlmičov
› Drive Mode Select

(možné len s P08/PJV/PJR)

PKS − 1238 − 625

Essence Selection Top Selection Monte CarloVolanty / interiéry / sedadlá

Essence Selection Top Selection Monte CarloDisky / pneumatiky

Essence Selection Top Selection Monte CarloKomfort
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Drive so Safe › Zadná parkovacia kamera
› Kessy - bezkľúčové odomykanie, zamykanie

a štartovanie
› Alarm
› Čierne lakované spätné zrkadlá a predná

maska
› 10" Virtuálny kokpit
› Sunset
› Sport Chassis Control–podvozok

s nastaviteľnou tuhosťou tlmičov
› Drive Mode Select

(možné len s P08/PJV/PJR)

PKW − 1494 687 845

Sunset 4KF − 174 • •

Open Sky › Panoramatická strecha
› Čierny strop
› Čierny strešný nosič
› Sunset
› Bez schránky na okuliare

(možné len s interiérmi AH/HQ/HO/JI)

WIW − 1003 − •

Chrome paket › Sunset
› Podokenná chromová lišta
› Strieborný strešný nosič

PIF − 403 • −

Open Sky pre Chrome › Panoramatická strecha
› Čierny strop
› Strieborný strešný nosič
› Bez schránky na okuliare

(možné len s interiérmi AH/HQ/HO/JI
a paketom PIF)

PMB − 834 834 −

Predné parkovacie senzory 7X2 − 367 • •

Zadná parkovacia kamera KA2 − 408 • •

Convenience so safe › Zadná parkovacia kamera
› Kessy - bezkľúčové odomykanie, zamykanie

a štartovanie
› Drive Mode Select
› Predné parkovacie senzory
› Alarm

WJM − 1003 • 253

Convenience Plus so safe › Naviac oproti Convenience so safe:
› Elektricky ovládané piate dvere s virtuálnym

pedálom
› 10" Virtuálny kokpit

WJN − 1681 678 939

Convenience Premium so
safe

› Naviac oproti Convenience Plus so safe
› Parkovací asistent

(PYC platí pre Top Selection)

WJO/PYC − 1805 802 1113

Convenience bez safe › Zadná parkovacia kamera
› Kessy - bezkľúčové odomykanie, zamykanie

a štartovanie
› Drive Mode Select
› Predné parkovacie senzory

WIM − 763 − •

Convenience Plus bez safe › Naviac oproti Convenience bez safe:
› Elektricky ovládané piate dvere s virtuálnym

pedálom
› 10" Virtuálny kokpit

WIN − 1438 − 725

Convenience Premium
bez safe

› Naviac oproti Convenience Plus bez safe
› Parkovací asistent

WIO − 1562 − 900

Essence Selection Top Selection Monte CarloKomfort
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Technology › 4 reproduktory vzadu
› Bezdrôtový Smartlink
› Lakťová opierka s JumboBox
› 2x USB -C vzadu

WIQ 575 • • •

Technology Plus › Phonebox bez LTE
› USB-C vo vnútornom spätnom zrkadle

(WIS platí pre Selection a Monte Carlo)
(WI2 platí pre Selection iba v kombinácii
s PLG/PLP/PLE/PLM)
(PI7 platí pre Top Selection)

WIS/WI2/PI7 − 201 201 290

Navi paket › 9.2" Škoda Navigation
› 10" Virtuálny kokpit
› Web Rádio
› Hlasové ovládanie
› Infotainment Online na 3 roky

WIT − 1272 1272 1272

Sound System Škoda, rezervné koleso (dojazdové), zdvihák + klúč na kolesá
(možné len s WIT a WQ3/WQ4/WQ7)

PJC − 534 534 534

Alarm PD1/PD3 276 276 • −

Color Concept (čierna strecha) 6FG − 540 540 520

Modrá Energy *UNI 0 0 0 0

Biela Candy *SPE 450 450 450 450

Metalické farby *MET 650 650 650 650

Červená Velvet, Oranžová Phoenix *FLT 1054 1054 1054 1054

Predĺžená záruka na 5 rokov/100 000km EA4 0 0 0 0

Predĺžená záruka na 5 rokov/150 000km EA9 205 205 205 205

• Základná výbava − Nie je v ponuke MPManuálna prevodovka AP Automatická prevodovka

Servis 5 rokov/75 000 km 818 1556

Servis 5 rokov/100 000 km 1046 2178

Servis 5 rokov/150 000 km 1526 3438

Essence Selection Top Selection Monte CarloMultimédiá

Essence Selection Top Selection Monte CarloZabezpečenie vozidla

Essence Selection Top Selection Monte CarloOstatné

Basic ProfessionalServisné balíčky
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Ponuka farieb a diskov

Oranžová Phoenix, metalická Červená Velvet, metalická Modrá Race, metalická Biela Moon, metalická

Čierna Magic, metalická Sivá Graphite, metalická Strieborná Brilliant, metalická Modrá Energy, uni

Biela Candy, uni

Oceľové disky 16"
s krytmi Tecton

Cortadero Aero 16"
strieborné

Nyota 16"
strieborné

Montado Aero 16"
čierne

Kajam 17"
strieborné

s aero krytmi

Stratos 17"
strieborné

Propus Aero 17"
čierne

Ursa Aero 18"
strieborné

s aero krytmi

Fornax 18"
strieborné

Vega Aero 18"
čierne

s aero krytmi

Kajam 17"
čierne

s aero krytmi

Ursa 18"
čierne
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Poznámky

Technické dáta vozidla nájdete v katalógu technických dát na stránke www.skoda-auto.sk.
Ceny uvedené v cenníku sú odporúčané ceny pre klienta v € vrátane DPH 23%.
Doplnková výbava znamená bohatšie vybavenie vozidla, nie zdvojenú výbavu. Konečnú cenu, výbavu a jej
možnú kombinovateľnosť konzultujte s autorizovaným predajcom značky Škoda.
Spoločnosť Škoda Auto Slovensko s. r. o. si vyhradzuje právo zmeny cien a špecifikácií
bez predchádzajúceho upozornenia. Všetky obrázky sú ilustračné.

Cenník platný od 01.01.2025 (MR2025)

Spoločnosť Škoda Auto sa usiluje o zodpovedný, trvale udržateľný vývoj spoločnosti a šetrný prístup k životu a prírode.

Váš autorizovaný partner značky Škoda
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